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Dealing with  
Digital Noise

If you shoot in low-lighting situations, you’re bound to encounter digital noise. 
Is there anything worse than these large red, green, and blue dots that appear all 
over your photo? Okay, besides that “crazy music” those teenagers play, like Limp 
Bizkit or…well…Limp Bizkit, is there anything worse? This digital noise (often 
called “Blue channel noise,” “high ISO noise,” “color aliasing,” or just “those annoy-
ing red, green, and blue dots”) can be reduced. Here’s how:

Step One: 
Open a photo that contains visible digi-
tal noise. Go ahead and do your color 
correction, and other adjustments first 
(like any Shadow/Highlight adjustments, 
Curves, etc.), because these will some-
times bring out noise in the image too. 
(In this case, the shot was taken at night 
with a point-and-shoot camera, and 
those red, green, and blue dots appear 
throughout the photo, but are especially 
visible in the sky. I know, it’s kind of 
hard to see the noise in the small photo 
shown here, so in the next step we’ll 
zoom in tighter so you can see the noise.)

Step Two: 
Go under the Filter menu, under Noise, 
and choose Reduce Noise. When the 
Reduce Noise dialog appears, click on 
the Plus (+) sign (that’s directly below 
the preview window) about four or  
five times to zoom into the sky area.  
To actually see the red, green, and  
blue noise pixels, click-and-hold within 
the preview area. This shows you the 
original image (before the filter is 
applied). Release the mouse button, and 
you’ll see how the Reduce Noise filter 
reduces the noise. This is a quick way to 
get a before and after: click to see the 
before—release to see the after.

Step Three: 
This filter seems to work best if you crank 
up the Strength fairly high (try 7 or 8). You 
want to find a sweet spot for keeping as 
much detail as possible, while still getting 
decent noise reduction, so try setting the 
Preserve Details slider between 40% and 
50%. You want to really work the Reduce 
Color Noise slider (start between 60% to 
70%, and then drag to the right for more 
reduction but without making the photo 
noticeably blurry). For Sharpen Details,  
keep that at no more than 15% to 20% 
(you’ll probably get better results if you  
use the Smart Sharpen filter next, rather 
than applying the sharpening here). Click 
OK to reduce the color noise.

TIP: Some digital cameras produce what’s 
called “Blue channel noise,” because that’s 
the channel where most of the noise  
winds up. To reduce that, click on the 
Advanced option, which lets you reduce 
noise in individual channels. Click on 
the Per Channel tab, and then from the 
Channel pop-up menu, choose Blue. Then, 
use the Strength slider to reduce noise in 
just the Blue channel.

Before After (with color noise greatly reduced 
using the Reduce Noise filter)
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Fixing Photos 
Where You  

Wish You Hadn’t 
Used Flash

There’s a natural tendency for people to react to their immediate surroundings, 
rather than what they see through the lens. For example, if you’re shooting an 
indoor concert, there are often hundreds of lights illuminating the stage. However, 
some photographers think it’s one light short—their flash—because it’s dark 
where they’re sitting. So when you look at your photos later, you see that your 
flash lit everyone in front of you, ruining an otherwise great shot. Here’s a quick fix 
to make it look as if your flash never fired at all:

Step One: 
Open a photo where shooting with the 
flash ruined part of the image (like the 
image shown here taken at Walt Disney 
World in Florida. The castle is beautifully 
lit, and that’s all we want to see, not 
the tourists, although I’m sure they’re 
perfectly nice people). Press L to get the 
Lasso tool and click-and-drag a selec-
tion around the part of shot ruined by 
the flash (in this case, the crowd on the 
street, who got lit by an inadvertent  
firing of the flash).

Step Two: 
Now we’re going to darken this selected 
area, but we don’t want our adjustment 
to appear obvious. We’ll need to soften 
the edges of our selection quite a bit 
so our adjustment blends in smoothly 
with the rest of the photo. To do this, 
go under the Select menu and choose 
Refine Edge. When the dialog appears, 
enter a Feather of 25 pixels to soften the 
selection edge. (By the way, 25 pixels is 
just my guess for how much this par-
ticular selection might need. The rule of 
thumb is the higher the resolution of the 
image, the more feathering you’ll need.)
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Step Three: 
It will help you make a better adjust-
ment if you hide the selection border 
(we call it “the marching ants”) from 
view. We don’t want to deselect—we 
want our selection to remain intact but 
without the annoying border, so press 
Command-H (PC: Ctrl-H) to hide  
the selection border. Now, press 
Command-L (PC: Ctrl-L) to bring  
up the Levels dialog. At the bottom of 
the dialog, drag the highlight Output 
Levels slider to the left to darken your 
selected area. Because you’ve hidden 
the selection border, it should be very 
easy to match the surroundings of your 
photo by just dragging this slider to the 
left. Now you can press Command-D 
(PC: Ctrl-D) to deselect, and then admire 
the final image.

Before: The flash is obviously a couple  
hundred yards short of reaching the castle.

After: The effect of the flash is hidden,  
saving the shot!
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One of the greatest advantages of shooting in RAW format is that you can go 
into Photoshop’s Camera Raw and adjust your Exposure setting after the fact. 
But if you weren’t shooting in RAW, you won’t have access to all of the Exposure 
options (you’d have to try to fix exposure problems using Curves or Levels). 
There’s a dedicated Exposure control that you can use on JPEGs, but it works a 
little differently than the one in Camera Raw (since it was actually designed for 
use on High Dynamic Range images, but it still works with regular 8-bit photos).

Step One: 
Open an underexposed photo. Go under 
the Image menu, under Adjustments, 
and choose Exposure to bring up the 
Exposure dialog (seen in the capture 
in Step Two. While you’re there, take 
a look at the three Eyedroppers—they 
work nothing like the ones in Levels and 
Curves—they only affect the photo’s 
luminance, so don’t get any cute ideas). 

Using the 
Exposure 

Adjustments

Step Two: 
The Exposure slider acts like the expo-
sure adjustment on your camera. 
Dragging the Exposure slider to the right 
(as we’re doing here) mostly increases 
the photo’s highlights, but also opens 
up some of the midtones as well (kind 
of like dragging the highlight Input slider 
in Levels to the left—it moves the mid-
tones slider, too). This Exposure slider 
will generally do most of the work in  
fixing your image.

Step Three: 
If you drag the Offset slider to the right 
(above 0), it kind of works like the Levels 
shadow Output slider (the one on the 
bottom-left of the Levels dialog) in that 
it lightens the overall image. However, 
if you drag the Offset slider to the left 
(below 0), it increases the shadow areas 
without really affecting the highlights 
(kind of like what the Levels shadow 
Input slider would do if you dragged it 
to the right). I know, it’s freaky. 
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Step Four: 
The Gamma Correction slider mostly 
affects the midtones and some high-
lights (kind of like the midtones slider in 
Levels). Dragging to the right opens up 
the midtone areas; dragging to the left 
darkens the midtones. 

TIP: Moving these sliders just a little can 
create a big adjustment, so here’s a trick 
to make smaller adjustments: hold the 
Command key (PC: Ctrl key) and move 
your cursor over the number field you 
want to adjust. Your cursor will change 
into a scrubby slider, and now you can 
click-and-drag within that field to adjust 
in smaller increments. 

Step Five: 
When I adjusted the Exposure in  
Step Two, it blew out the detail in the 
headlights. Here’s how I got around 
it—I started over. First I duplicated 
the Background layer by dragging it 
to the Create a New Layer icon, and 
then I clicked on its Eye icon to hide it 
from view. Then, I ran Exposure (set to 
+1.40) on the Background layer, made 
the duplicate layer visible again and did 
Steps Two-Four. Then, I clicked on the 
Add Layer Mask icon with the duplicate 
layer active, and using the Brush tool (B), 
painted over the headlights (in black) to 
reveal the +1.40 Exposure headlights on 
the Background layer. Give that a try.

After (using the Exposure feature and adding  
a layer mask for the headlights)

Before
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Repairing  
Problems  

Caused by  
the Lens

In Photoshop CS2, Adobe introduced a new filter that is pretty much a  
“one-stop-shop” for repairing the most common problems caused by the  
camera’s lens, including pincushion and barrel distortion, horizontal and  
vertical perspective problems, chromatic aberrations, and vignetting. Before  
CS2, you could only fix chromatic aberrations and vignetting if you were  
shooting RAW, because the fixes only appear in Camera Raw, but now you  
can apply these quick fixes on JPEG images as well.

Problem One: Perspective Distortion
Step One: 
The first problem we’re going to tackle  
is some perspective distortion. In the 
example shown here, the bases of the 
buildings look smaller than the tops  
(especially the building on the left), which 
gives the photo an almost a cartoon-like 
perspective (but believe me, your client 
won’t think its funny). 

Step Two: 
To fix this problem (caused by the lens), 
go under the Filter menu, under Distort, 
and choose Lens Correction. When the 
dialog appears, turn off the Show Grid 
checkbox (it’s on by default), then go 
to the Transform section (near the bot-
tom-right side of the dialog) and drag 
the Vertical Perspective slider to the right 
until the buildings start to look straight 
and not so top-heavy. When you make 
this correction, the filter pinches the top 
third of your photo inward, which leaves 
transparent gaps along the top and  
upper-side edges of your photo (you can 
see the checkerboard in these areas).

Step Three: 
The Edge pop-up menu at the bot-
tom of the Transform section lets you 
decide how to deal with these edge 
“gaps” caused by the perspective repair. 
From the pop-up menu, choose Edge 
Extension, which extends the edge areas 
of your photo to cover those gaps, and 
click OK to apply the fix. Note: You’ll 
still need to do some clean-up to hide 
some of the stretched areas created by 
the Edge Extension, so just use the Clone 
Stamp tool (S) or the Healing Brush (J).
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Before: The bases of the buildings are smaller than the tops.  After: The perspective distortion is corrected.
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Problem Two: Barrel Distortion
Step One:
Another common lens correction problem 
is called barrel distortion, which makes 
your photo look bloated or rounded. So, 
open the Lens Correction filter again, but 
this time you’re going to drag the Remove 
Distortion slider (in the top right of the 
dialog) slowly to the right to “pucker” the 
photo inward from the center, removing 
the rounded, bloated look. If you want a 
more visual way to do this correction, try 
the Remove Distortion tool (it’s at the top 
in the Toolbox on the left). Click-and-drag 
it toward the center of your photo to 
remove barrel distortion (or toward an edge 
to remove pincushion distortion, in which 
the sides of your photo appear to curve 
inward). It’s hard to make minor adjust-
ments using the tool, so you’ll probably 
wind up using the slider most of the time. 

Step Two: 
When you click OK, the correction will leave 
gaps around the edges, so get the Crop 
tool (C) and re-crop the image to hide the 
missing edges. It’s hard to see the difference 
in the small images below, but try this tech-
nique, and you’ll see the difference.

Problem Three: Lens Vignetting
Step One:
Vignetting is a lens problem where the 
corners of your photo appear darkened. 
To remove this problem, go back to the 
Lens Correction filter.

Step Two:  
In the Vignette section of the dialog, 
drag the Amount slider to the right, and 
as you do you’ll see the edges brighten. 
Keep dragging the slider until the edges 
match the brightness of the rest of the 
photo. The Midpoint slider (just below 
the Amount slider), determines how far 
into the photo your corner brighten-
ing will extend. In this case, you have 
to extend it just a little bit by dragging 
the slider to the left (as shown here), 
then click OK. Note: You can also fix 
chromatic aberrations (colored-edge 
fringing). To see what that is and how 
to fix it using this filter (which works 
similarly to Camera Raw), check out the 
“Fixing Chromatic Aberrations” tutorial 
in Chapter 3.
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After (removing the bloating caused by barrel distortion)Before Before: You can see the dark vignetted areas in the corners. After: The vignetting is completely removed.

sc


o
tt

 k
e

lb
y



13 Chapter 8 Dealing with Common Digital Image Problems

The Adobe Photoshop CS3 Book    for Digital Photographers

14Chapter 8Dealing with Common Digital Image Problems

The Adobe Photoshop CS3 Book    for Digital Photographers

Saving  
Blurry  

Photos

This is a simple technique I came up with that enables you to save a blurry photo 
from the trash, but you have to know up front—there are limitations. First, it pro-
duces a photo that is really only suitable for emailing to friends and family, using in 
slide shows, or creating a 4x6" print. If you’re okay with that, it works wonders. It’s 
based on the premise that everything looks in focus when it’s small (for proof of 
that, see the LCD monitor on the back of your camera, where every photo looks in 
focus, but when you open the full-size photo in Photoshop, you find out the truth).

Step One: 
Open your blurred digital image. In  
the example shown here, I used a  
blurry high-res image imported directly 
from my digital camera and opened  
in Photoshop.

Step Two: 
Go under the Image menu and choose 
Image Size (by the way, there’s a 
keyboard shortcut for Image Size: 
Command-Option-I [PC Ctrl-Alt-I]). 
When the dialog appears, you’re going 
to leave the physical size alone (so it will 
still be 10" wide), but you’re going to 
lower the Resolution from 300 ppi to  
72 ppi, and then click OK. Note: If you’re 
already working with a low-res image, 
you won’t need to lower your Resolution 
setting (sorry, just in case you didn’t 
know that already).

Step Three: 
To get the resolution high enough to  
print to a color inkjet printer, go back 
to the Image Size dialog again. Turn off 
Resample Image and lower the Width  
to 6" (giving you a 6x4" finished size at  
120 ppi in this case). 

Step Four 
This is where the Smart Sharpen filter 
really works wonders. Go under the Filter 
menu, under Sharpen, and choose Smart 
Sharpen. When the dialog appears, set the 
Amount at 58%, leave the Radius set to  
1 pixel, ensure the Remove pop-up menu 
is set to Gaussian Blur, turn on the More 
Accurate checkbox, and click OK to apply 
this first level of sharpening. Now, press 
Command-F (PC: Ctrl-F) to run Smart 
Sharpen again, using the same settings. 
This second pass of sharpening really does 
the trick.

After: Thanks to Smart Sharpen, she doesn’t look oversharpened.Before: This was one you’d simply delete.
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Repairing 
Keystoning

Keystoning is often found in photos with buildings or tall objects, where the 
buildings look as if they’re falling away from the viewer (giving the impression 
that the tops of these buildings are narrower than their bases). The Crop tool has 
a Perspective function that can be used to fix these distortions, but actually I’m 
going to recommend that you don’t use it, because it doesn’t offer a preview of 
any kind—you’re left guessing—so use this technique instead.

Step One: 
Open an image that has a keystoning 
problem (such as the photo shown here, 
taken with a wide-angle lens, where the 
towers of this old church seem to be 
leaning away from the viewer).

Step Two: 
Press Command-R (PC: Ctrl-R) to make 
Photoshop’s rulers visible. Grab the bot-
tom-right corner of your image window 
and drag outward to reveal the gray 
canvas background. Press Command-A 
(PC: Ctrl-A) to select your entire image, 
and then press Command-T (PC: Ctrl-T) 
to bring up the Free Transform function. 
Grab the center point of the bounding 
box and drag it straight downward until 
it touches the bottom-center point.

Step Three: 
Click-and-drag out a guide from the 
left ruler into your photo (we’ll use 
this straight guide to help us align our 
building). In this example, I lined up the 
guide with the left side of the building. 
Once you add this guide, you can really 
see how far back the building seems to 
be leaning and why a keystoning repair 
is so necessary.

Step Four:
Once your guide is in place, hold the 
Command key (PC: Ctrl key) and drag 
the top-left corner point of the bound-
ing box upward and to the left until the 
left side of the tower touches your guide. 
It already looks better, but if you look 
at the line that separates the different 
levels (under the windows), you can see 
it’s still tilted upward, so you’ll have to 
fix that next.
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Step Seven: 
When the photo looks right, press 
Return (PC:�Enter) to lock in your 
transformation. (Note: By repairing this 
problem with Free Transform, you saw 
an onscreen preview of what you were 
doing, which the Crop tool’s Perspective 
feature doesn’t offer.) Now, if after 
making this adjustment, the build-
ing looks a bit “round” and “bloated,” 
you can repair that problem by going 
under the Filter menu, under Distort, 
and choosing Pinch. Drag the Amount 
slider to 0% (toward the center of the 
slider), and then slowly drag it to the 
right to increase the amount of Pinch, 
while looking at the preview in the filter 
dialog, until you see the roundness and 
bloating go away. (In this case, I used 2% 
for my Amount setting.) When it looks 
right, click OK to complete your key-
stoning repair.

Step Five: 
To make that edge straighter, drag the 
bottom-right corner point down a bit 
(don’t forget—keep holding down the 
Command/Ctrl key). You might also 
have to drag the top-right corner point 
upward, just to get the building looking 
a little more flat. 

Step Six: 
Making all these corrections can some-
times make your building look a bit 
“smushed” and “squatty” (my official 
technical terms), so you can release the 
Command/Ctrl key, grab the top-center 
point, and drag upward to stretch the 
photo back out and fix the “squattiness” 
(again, technically speaking).

Before: The tower appears to be “falling away.” After: The same photo after repairing the  
perspective distortion (known as keystoning). 



19 Chapter 8 Dealing with Common Digital Image Problems 

The Adobe Photoshop CS3 Book    for Digital Photographers

20Chapter 8Dealing with Common Digital Image Problems 

Continued

The Adobe Photoshop CS3 Book    for Digital Photographers

Step Three: 
Now move directly to your right and 
begin painting with the Clone Stamp 
tool. As you paint over the palm frond 
on the left side of the tree, the ocean 
you sampled is cloned right over it, so 
it looks like the palm has disappeared. 
Paint a little in this area to get a feel for 
how the Clone Stamp works (at least, if 
it’s your first time cloning; if it’s not, then 
you know what to do—start cloning 
over that palm). 

Step Four: 
The key technique to remember here 
is to sample just to the left of the palm 
(sampling in the sky and ocean), then 
move straight over to the palm. Now, 
in the captures shown here, the little 
“plus-sign” cursor (the area where you 
sampled) is just to the immediate left 
of the circular brush cursor (where 
you’re painting now). By keeping them 
side-by-side like that, you’re making 
sure you don’t pick up patterns or col-
ors from other parts of the photo that 
would make your cloning look obvious. 
In the next step, I’ll intentionally sample 
from the middle-left side of the photo, 
and then move to the top and start 
painting. Then, you’ll see how obvious it 
looks when you don’t sample near the 
area you’re trying to cover. 

TIP: There’s a trick to cloning that  
horizon line and keeping it straight. 
See the next tutorial called “Removing 
Things in a Straight Line.”

Cloning  
Away  

Unwanted  
Objects

The Clone Stamp tool has been the tool of choice for removing distracting or 
other unwanted objects in photos for years now. Although the Healing Brush  
and Patch tool in many ways offer a better and more realistic alternative, there  
are certain situations where the Clone Stamp tool is still the best tool for the job. 
Here’s an example of how this workhorse removes unwanted objects:

Step One: 
A photo of a palm tree on a tropical 
island near a shutter window is usually 
not a bad thing. But then when you  
see that palm, it’s usually not as ratty-
looking as the one shown here. In  
fact, it looks so ratty (and the light is  
so unflattering on it), I think it would 
look better if it weren’t there at all  
(and what luck—this is a chapter about 
removing unwanted objects). So our 
project, in short, is to cut down that 
palm tree. Digitally.

Step Two: 
Press S to get the Clone Stamp tool. In 
the Options Bar, click on the thumbnail 
to the right of the word “Brush” and 
choose a medium, soft-edged brush in 
the Picker. Now, Option-click (PC: Alt-
click) in an area of ocean just to the left 
of the palm. This is called “sampling.” 
You just sampled some ocean, and in  
the next step, you’re going to clone  
that ocean area over the part of the  
palm tree to the immediate right.  
(By the way, when you sample, that  
little “target” cursor appears, letting you  
know you’re sampling.)
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Step Five: 
Look at the plus-sign cursor (near the 
middle left of the palm). That’s where I 
sampled, but instead of moving directly 
to the right to clone a nearby area, I 
moved my brush to the top (just under 
the horizon on the right of the palm) 
and started painting. Look how much 
darker (and obvious) the cloning looks. 
That’s why you have to paint very  
close to where you sample. If not, it’s  
a dead giveaway.

TIP: Sample often (by Option/Alt-click-
ing) in different but nearby areas so that 
your cloning appears random, therefore 
avoiding repeating patterns in the waves, 
for example. 

Step Six:
Use this same technique of sampling to 
the left of the palm, painting over the 
trunk and palm fronds to the right of 
where you sampled, until the trunk and 
fronds are gone, except the tricky part at 
the top where the fronds meet the roof.

Step Seven: 
To keep from cloning over the roof, 
you’ll need to put a selection (a barrier) 
around the remaining palm fronds in the 
sky area. Since you can only paint inside 
the selected area, you don’t have to 
worry about cloning away the roof. First, 
press Z to get the Zoom tool and zoom 
into the palm and roof area. Now press 
Shift-L until you have the Polygonal Lasso 
tool. Click along the straight edges of the 
roof to draw a straight-lined selection 
(like the one shown here) that traces 
around the roof edge, around the palm 
fronds, and returns to where you first 
clicked on the roof.

Step Eight: 
Now, get the Clone Stamp tool again, 
sample the sky to the left of your selection, 
move over to the right inside your selec-
tion, and start cloning away the fronds. 
You can clone right up to the edge of the 
roof without worry, because you can’t 
paint “outside the lines” thanks to that 
selection you created in the previous step. 
Note: The sample point will be outside  
the selected area, and that’s fine—you can 
sample from anywhere.

Step Nine:
Keep painting (cloning) until the rest 
of the palm fronds around the roof are 
gone. Then, you can deselect by press-
ing Command-D (PC: Ctrl-D). Now, after 
all that, I hope you like the image better 
without the palm, as it took less than five 
minutes to remove it. If not, just go under 
the File menu, choose Revert, and that 
butt-ugly palm will come crashing back  
into your photo, ruining an otherwise  
uninspired image.

Before After
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Removing  
Things in a  

Straight Line

This is an incredibly handy little trick I learned from Rich Harris, who contributes 
some great tutorials to our magazine, Photoshop User (www.photoshopuser.com), 
and I’ve found no better way to clone away objects that need to be straight  
(like horizons, walls, etc.). Thanks to Rich for sharing this technique with us.

Step One: 
Press S to get the Clone Stamp tool, and 
then press-and-hold the Option (PC: Alt) 
key. Take a look at your cursor (shown 
here enlarged in the white box). See 
the horizontal line in the center of the 
circle? That’s the key. You must position 
the cursor’s center “target” line on the 
straight edge that you want to clone in 
your image (in this case, the top edge of 
a car’s front bumper). With the Option/
Alt key held down, click once when the 
target (called the “sample cursor”) is 
aligned on the edge in your image. 

Step Two:
Now drag directly to the right while 
pressing-and-holding the Option/Alt key, 
but don’t click. With this key held down, 
align the sample cursor’s horizontal  
center line with the bumper’s edge.

Step Three:
With the horizontal line positioned 
along the edge in your photo, release  
the Option/Alt key and start cloning.  
As you clone, paint along the same 
straight line. It’s all about making sure 
that the cursor’s horizontal line is aligned 
with the edge in your image before you 
start painting. 

If there are just one or two annoying things that are messing up your  
otherwise lovely photo, here’s a quick way to get rid of them, while  

maintaining maximum texture and authenticity (because you’re using  
another part of the photo to cover what you don’t want visible,  

so the grain, texture, and well—everything—is right on the money).

Covering  
Unwanted  
Elements

Step One: 
In this example, we have a charming 
“old-world” door, but the plastic “16” 
house number pulls the charming “old-
world” feel right out of the photo. So…
the plastic numbers have to go. I could 
use the Patch tool (it’s isolated, right?) or 
the Clone Stamp tool, but this method 
makes the removal perfect because 
you’re actually going to cover the “16” 
with a chunk of the wall above it, which 
is an even more realistic fix and is as fast 
as, if not faster than, the alternatives.

Step Two: 
Press Z to get the Zoom tool and zoom 
in on the area with the offensive plastic 
numbers. (I bet they got those at Euro-
Home Depot.)

Continued
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Step Three: 
Press M to get the Rectangular Marquee 
tool, and drag out a selection around 
the “16.” Then, click in the selection and 
drag it straight above the number, slid-
ing right up the wall. Now, you’ll need 
to put a feather on your selection so the 
edges will be soft and blend in perfectly, 
hiding the fact that you did anything to 
the photo at all. So, go under the Select 
menu and choose Refine Edge. When  
the Refine Edge dialog appears, enter 1–3 
pixels (depending on your percentage of 
zoom) for the Feather and click OK. 

Step Four: 
Now, holding the Command and Option 
(PC: Ctrl and Alt) keys, drag the selected 
area straight down. This makes a copy  
of the selected area, so you’re really 
dragging along a copy of the rectangu-
lar chunk of the wall. That area fits  
perfectly over the plastic numbers (it  
fits perfectly because you first created 
that selection by dragging it over the 
numbers, remember?). By the way, you 
won’t see any harsh edges to give you 
away because you feathered those edges 
in the previous step.

Step Five: 
Now, when you press Command-D  
PC: Ctrl-D) to deselect, the numbers 
will be gone, and your removal will be 
right on the money. Here’s a before 
and after. You can see what a differ-
ence removing that one little area 
made. I probably would go one step 
further and zoom in on the center of 
the red door. Then, using the same 
technique, I’d remove the letter “A” 
and peephole from the top center of 
the door. (That way, I’m removing any 
hint to the possibility of “old-world” 
crime that peepholes suggest.)

Step Six: 
Here’s another application of the  
same technique. On the left side of the  
photo there’s a distracting doorjamb, 
and the easiest fix (without re-cropping 
and shrinking the width of the photo) 
is to extend the wall to cover the door-
jamb. Get the Rectangular Marquee 
tool, and draw a tall, thin rectangular 
selection from the top to the bottom, 
and then feather your selection (under 
the Select menu, under Refine Edge).

Step Seven: 
Hold Command-Option (PC: Ctrl-Alt) 
and the Shift key (to keep it perfectly in 
line as you drag), and drag the selected 
area of the wall to the left. You’ll have 
to drag several copies of the thin wall 
selection to cover the doorjamb. Also, 
if you see any repeating pattern when 
you’re done, just get the Patch tool 
(Shift-J), draw a selection around that 
area, drag the selection into a clean area, 
and then press Command-D (PC: Ctrl-D) 
to deselect.
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In Photoshop CS2, Adobe added the Spot Healing Brush tool, which is just about 
the perfect tool for getting rid of spots and other artifacts. (By the way, the term 
“artifacts” is a fancy “ten-dollar” word for spots and other junk that wind up in 
your photos.) Believe it or not, it’s even faster and easier to use than the regular 
Healing Brush, because it’s pretty much a one-trick pony—it fixes spots.

Step One: 
Open a photo that either has spots 
(whether they’re in the scene itself or 
are courtesy of specks or dust on either 
your lens or your camera’s sensors). In 
the photo shown here (featuring my son 
Jordan, posing with a Slik Carbon Fiber 
tripod with a Slik AF2100 trigger-style 
ballhead; you have to admit, he has 
great taste in tripods), there are all  
sorts of distracting little white spots  
on the pavement.

Step Two: 
Press Z to get the Zoom tool and zoom 
in on an area with lots of spots (in this 
case, I zoomed in on the lower left-hand 
corner of the image). Now get the Spot 
Healing Brush tool from the Toolbox  
(or just press the letter J).

Removing  
Spots and  

Other Artifacts

Step Three: 
Position the Spot Healing Brush directly 
over the spot you want to remove and 
click once. That’s it—you don’t have  
to sample an area or Option/Alt-click 
anywhere first—you just move it over 
the spot and click—the spot is gone. 

Step Four: 
You remove other spots the same  
way—just position the Spot Healing 
Brush over them and click. I know it 
sounds too easy, but that’s the way it 
works. So, just move around and start 
clicking away the spots. Now you can 
“de-spot” any photo, getting a “spotless” 
version, in about 30 seconds, thanks to 
the Spot Healing Brush.
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Removing 
Distracting Objects 

(Patch Tool)

Okay, if the Clone Stamp tool is so great, why should you even use the Patch tool? 
Two reasons: (1) it’s faster, and (2) it’s better—much better—because it keeps more 
of the original texture and the fix looks more realistic. Okay, so why not use the 
Patch tool all the time? Because it has a major limitation: it only does a great job 
of removing things that are isolated all by themselves. When your object gets near 
the edge of another object (or the edge of your image area), it doesn’t work worth 
a darn. So you’ll see how it works, why it doesn’t always work, and a great trick for 
making it work most of the time (with some help from the Clone Stamp tool).

Step One: 
Here’s a photo of the magnificent La 
Sagrada Familia church in Barcelona. 
There’s quite a bit of construction going 
on (as you can see), and since I’m not a 
photojournalist, I don’t want to see all 
those cranes that detract from Gaudi’s 
amazing architecture. So, we’re going to 
use the Patch tool (and a little bit of the 
Clone Stamp tool) to remove all those 
cranes from the skyline.

Step Two: 
First we’ll look at how the Patch tool 
works, and then you’ll see what the 
limitation of the Patch tool is. Start by 
pressing Z to get the Zoom tool and 
zoom into an area you want to remove. 
Press Shift-J to get the Patch tool (or 
look under the Spot Healing Brush in the 
Toolbox), and draw a selection around 
something you want to remove. At this 
stage, the Patch tool works just like the 
regular Lasso tool, so click-and-drag to 
make a freeform selection like the one 
shown here. 

TIP: If you need to add to your selec-
tion, press-and-hold the Shift key, or to 
subtract from your selection, press-and-
hold the Option (PC: Alt) key.

Step Three: 
Once your selection is in place, click your 
cursor inside the selected area (the cur-
sor will change to an arrow) and drag  
the entire selection into an area of the 
photo that has a similar texture and 
color (like I have here, where I dragged 
into some open sky). 

Step Four: 
When you release the mouse, the 
Patch tool’s selection snaps back to its 
original location (where you first drew 
it), and it erases what was there. Ahh, 
now you see the problem: where the 
edges of the selection meet the rest of 
the crane, it’s all smudged. As bad as 
it looks here, believe it or not, this is 
pretty mild compared to what often 
happens when the area you’re patching 
isn’t isolated. The Patch tool only gives 
you a clean patch-job if you can drag 
a selection around the entire object 
without hitting an edge.

Step Five: 
Undo this patch-job by pressing 
Command-Z (PC: Ctrl-Z), and then 
deselect by pressing Command-D (PC: 
Ctrl-D). Now we’ll try getting around 
that limitation: Press S to switch to the 
Clone Stamp tool, and Option-click 
(PC: Alt-click) to sample an area below 
the crane.
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Step Six: 
Move the Clone Stamp tool to the left 
(right over the center of the crane) and 
clone the blue sky you sampled, putting 
a break in the crane.

Step Seven:
Now do the same thing on the right 
side of the crane—sample a nearby area 
by Option/Alt-clicking, and then clone 
over a middle section of the crane. By 
doing this, you’ve isolated the top of 
the crane—it’s no longer connected to 
the ends of the crane, which means now 
you can put a selection around the top 
of the crane using the Patch tool, totally 
encircling it without touching any edges.

Step Eight: 
So now it’s time to repeat Steps One and 
Two: get the Patch tool, put a selection 
around isolated parts of the crane, and 
then click in the center of your selection 
and drag to an open area of sky near the 
crane. Note: Use the Zoom tool to zoom 
out if needed.

Step Nine: 
When you release the mouse button, it 
snaps back, creating a perfect patch—
with perfect texture—and no smudged 
edges. It’s a precise, seamless fix using 
this new trick! Just press Command-D 
(PC: Ctrl-D) to deselect.

Step Ten:
Getting rid of the top-right side of 
the crane is simple because it’s now 
isolated—just draw a Patch tool selec-
tion around it, drag the selection into 
a different area, let it snap back, and—
BAM—it’s gone!

Step Eleven: 
Alright, are you ready for a little more of 
a challenge? Take a look at the crane on 
the left of the image. It’s right up against 
one of the towers. Now what? You do 
the same thing; it just takes one extra 
step to ensure you don’t accidentally 
clone over some of the church (I’ll show 
you the trick for that in the next step).
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Step Twelve: 
First, use the Zoom tool to zoom in tight 
on the area where the crane meets the 
church. Press L to switch to the regular 
Lasso tool and trace along the edge of 
the church where the crane comes out. 
It sounds harder than it is, but because 
you’re only tracing for about an inch, it’s 
easier than you’d think. Trace along the 
church edge, drag to the left to select 
part of the crane, and then click back to 
where you first started your edge selec-
tion, creating a selection like the one you 
see here.

Step Thirteen:
When you make a selection like this, 
you’re basically putting up a fence, 
because now any cloning you do with 
the Clone Stamp tool will appear only 
inside that “fence,” so it’s impossible to 
accidentally erase part of the church 
(in other words, you can’t paint outside 
that selected area—only inside it). So, 
get the Clone Stamp tool, Option/Alt-
click in the sky near the edge of the 
church, and clone in the sky over the 
end of the crane.

Step Fourteen: 
Once you’ve pressed Command-D  
(PC: Ctrl-D) to deselect, zoom out a bit 
with the zoom tool. Now, switch to the 
Patch tool and draw a selection around 
the crane (since there’s now a break 
between the church and the crane). 
Then, click inside the selection and drag 
your Patch tool selection into an open 
area of sky.

Step Fifteen: 
Release the mouse button, and once 
your selection snaps back to remove 
the crane cleanly, deselect by pressing 
Command-D (PC: Ctrl-D). You’re going 
to continue to use this same technique 
of isolating parts of the crane and draw-
ing a Patch tool selection around them 
until all the cranes are gone. Again, 
could you have used the Clone Stamp 
tool for the whole process? Yes. Would 
it have taken you longer? Yes. Would it 
have looked blotchier and more obvious 
that things were removed? Probably. The 
Patch tool is just that much better, so 
if you can find a way to use it (like we 
did here), you’re better off in more ways 
than one.

Before After
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Step Three: 
Use the tool to trace down the yellow 
line. You can pretty much see what’s 
going on here—I’m simply tracing the 
area that has the perspective angle of  
the photo. 

TIP: When you’re placing these points  
far away (like I am here), you can tem-
porarily zoom in to make sure you’re 
aligning them correctly by pressing the 
letter X.

Step Four: 
When you reach the original point you 
started with, a blue grid will appear. 
Well, hopefully it’s a blue grid. If it’s 
blue, it means you drew it correctly, 
and Vanishing Point is happy with you. 
If it’s yellow, it means that you’re close, 
and it may work, but you’d be better off 
switching to the Edit Plane tool (V) (it 
looks like an arrow) and adjusting your 
points until they turn blue. If your grid 
outline turns red, it’s a bad grid (your 
perspective isn’t right), and you’ll need 
to tweak the points until it’s right.

Step Five: 
Once your blue grid is in place, you can 
stretch it to cover the object you want 
to remove. Just click on one of the cen-
ter points using the Edit Plane tool, and 
drag in the direction you want the grid 
to spread. In the example shown here, 
I grabbed the right-center point and 
dragged it over to the right until Dave’s 
legs and feet were covered.

Step One: 
Here’s a photo of my buddy Dave Moser. 
We were shooting the International 
Car Show on press day (which is why 
you only see cleaning crew in the back-
ground), and Dave was lying on his 
back shooting a Hummer H2 that was 
positioned on an angle. Where’s Dave’s 
tripod, you might ask? I asked the same 
question, but apparently Dave doesn’t 
mind camera shake (kidding). Anyway, 
since he didn’t use a tripod, he should 
be cloned out of this photo to hide the 
evidence. Start by clicking on the Create 
a New Layer icon in the Layers panel so 
we can do our cloning work on a new 
blank layer.

Step Two: 
Go under the Filter menu and choose 
Vanishing Point (it’s near the top). First, 
you have to define the angle of perspec-
tive by drawing with the Create Plane 
tool (C). (Don’t let the fancy name throw 
you—you use it pretty much like you 
would the Polygonal Lasso tool.) Just 
click where you want to start, and keep 
clicking at angles to create your selection. 
(Here, I clicked halfway down the road 
along the carpet’s edge, clicked at the end 
of the carpet at the bottom of the image, 
and then clicked again where I thought 
the road’s yellow line would end.)

Removing  
Things in 

Perspective

Until Photoshop CS2’s introduction of the Vanishing Point filter, cloning away 
things in perspective was one of the hardest removal tasks of all. Luckily, this 
incredibly cool filter not only simplifies removing things in perspective, it actually 
makes it fun. In fact, this is one of those filters that’s so amazing, you can wind 
up spending hours cloning away things that have no business being cloned away. 
Don’t say I didn’t warn you.
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Step Six: 
Press S to switch to the Stamp tool  
(it looks like the Clone Stamp tool), 
and the grid in the center will go away, 
leaving just the blue outline to show 
the boundaries of the grid. Option-
click (PC: Alt-click) on a straight line 
in your image (if possible) to help you 
line things up. In this case, I Option/Alt-
clicked on the line where the black and 
gray carpets meet.

Step Seven:
Now, just move up that line and click-
and-drag to start painting. As you do, 
the unwanted object (Dave) is removed, 
and the cloning automatically adjusts 
for the perspective. In this example, you 
can see how the white line automatically 
shrinks as it moves away.

Step Eight: 
Like the regular Clone Stamp tool, if you 
paint too far, it starts cloning over itself 
(meaning it’s picking up other objects) 
so just paint a little bit (say 1/2" or so); 
then move to a different area, Option/
Alt-click again, and this time clone over 
the legs. Again, just clone away a little of 
his legs at a time—don’t try to remove 
them all at once, or you’ll start cloning 
objects back in.

Step Nine: 
Continue using this technique to clone 
away other unwanted areas. Remember 
to Option/Alt-click several times to  
keep the retouch looking random, and 
to keep from “repeat” cloning. When  
it looks good to you, click OK in the  
dialog. Since the cloning will appear on  
a separate layer, you can adjust it or  
easily erase any extra areas using the 
Eraser tool (E) (if you cloned too large 
an area, for example). With the perspec-
tive right on the money, Vanishing  
Point works wonders.

TIP: If you notice any repeating patterns 
in your cloning, just click on Layer 1,  
get the Patch tool (Shift-J), draw a selec-
tion around one of the repeating pat-
terns, drag the selection into a new area 
on that layer, and the repeating pattern 
will be removed. Press Command-D  
(PC: Ctrl-D) to deselect.

Before After
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Removing 
Backgrounds

Step One: 
Open the photo containing a person 
(or an object) that you want to extract 
from its background. Go under the Filter 
menu and choose Extract (it’s the first 
filter from the top). 

Step Two: 
This brings up the Extract dialog. Press B 
to get the Edge Highlighter tool (it’s the 
top tool in Extract’s Toolbox and looks 
like a marker), and trace the edges of 
the object you want to remove. As you 
trace, leave half the marker border on 
the background and half on the edge of 
the object you want to extract.

TIP: Use a small brush size when tracing 
areas that are well defined (like along the 
shirt), and a very large brush for areas 
that are less defined (such as flyaway 
hair). You can change the brush size by 
holding down the Left Bracket key to 
make it smaller or the Right Bracket to 
make it larger.

I figured I’d include probably the most-requested masking task—removing  
someone from a background while keeping hair detail. We use Extract for this,  
and even if you’ve used Extract dozens of times, there’s a trick near the end that  
is so simple, yet so incredibly effective, it will change the way you use Extract  
forever, or my name isn’t Deke McClelland.

Step Three:
After your Highlighter edge is in place, 
you now have to tell Photoshop what 
parts of the photo to retain when 
extracting. This is pretty simple—you 
just press G to switch to the Fill tool  
(it’s the second tool from the top in 
Extract’s Toolbox and looks like a paint 
bucket), and click it once inside the 
Highlighter edge border you drew earlier. 
This fills the inside of your highlighter 
border with a blue tint. 

Step Four:
If the blue tint spills out into the rest of 
your photo when you click the Fill tool, 
that means your subject isn’t completely 
enclosed by the edge border. If that hap-
pens, just press Command-Z (PC: Ctrl-Z) 
to undo, then take the Edge Highlighter 
and make certain there are no gaps at 
the bottom or sides of your border. Now 
you can click on the Preview button to 
see how your extraction looks. 

Step Five: 
It’s time to take a good look at the 
photo and see if Extract did what you 
really wanted it to. Namely, did it work 
on the hair, which is the hard-to-select 
area? If it worked, then click OK because 
fixing the rest of the photo is a breeze, 
as you’ll see. Even if parts of his clothes 
are dropping out, or there are dropouts 
in his face, hands, etc., don’t sweat it—as 
long as the edge of the hair looks good, 
go ahead and click OK to perform the 
extraction and your image will appear on 
an editable layer (Layer 0).
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Step Six:
Now that the extraction is done, it’s  
“fix-up” time. Here, you can see dropouts 
(slightly transparent areas) in his hair, a 
few little spots in his shirt, and a couple 
of little spots in other places. Start by 
simply duplicating the layer. That’s right, 
just press Command-J (PC: Ctrl-J). The 
mere act of duplicating the layer will 
fix about 90% of the dropouts in your 
photo. It sounds weird, but it works 
amazingly well, and when you try it,  
you’ll be astounded. Press Command-E 
(PC: Ctrl-E) to merge these two layers.

Step Seven:
For the rest of the dropouts, press Y to 
get the History Brush tool and simply 
paint over these areas. The History Brush 
will paint those missing pieces back in 
because it’s really an “undo on a brush.” 
So, if part of your subject drops out, use 
the History Brush to paint it right back 
in. You can usually fix the dropouts in 
about two minutes using this technique.

Step Eight:
During the fix-up stage, I’m painting over 
dropouts along the man’s shoulder. As 
you see, using the History Brush paints 
the original image back in.

Step Nine:
Next, open the photo that you want 
to use as a background behind your 
extracted person. It’s best to drag this 
background photo onto your extracted-
person document, because as long as 
you work in the same document where 
you extracted, you’ll have access to the 
History Brush for your extracted image. 
That way, if you see a dropout when 
you bring in the background, you can 
return to that layer and quickly touch it 
up with the History Brush. So press V to 
switch to the Move tool, and drag-and-
drop this photo on top of your extracted 
image. The background will appear on 
top of your extracted image on a sepa-
rate layer (Layer 1) in the Layers panel.
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Step Ten:
In the Layers panel, drag the layer 
with your background photo (Layer 1) 
beneath the layer with your extracted 
photo, putting your extracted person in 
front of the background (as shown here, 
where the man in the background photo 
is partially covered by the extracted 
man). Using the Move tool, position this 
background layer until your extracted 
person appears where you want him. 
Then, you’ll usually have to switch to 
the Eraser tool (E) to erase any leftover 
“junk” outside his hair, along his shirt, 
etc., but you can usually clean up these 
leftovers pretty easily once you see them 
over the background.

Step Eleven:
In this example, because I only want part 
of the background to appear, I’m stuck 
with a lot of empty space and unneeded 
areas. Press the letter C to get the Crop 
tool, drag a cropping border around the 
areas you want to keep, and then press 
Return (PC: Enter) to crop the photo 
down to size. Now that the photo is 
cropped, a new problem is visible—his 
skin tone looks too warm for the bluish 
background we’ve placed him on (and 
this is something you’ll deal with often 
when combining photos—the tones 
have to match to look realistic).

Step Twelve:
To cool down his warm skin tones, make 
sure the top layer is active in the Layers 
panel, and then go under the Create 
New Adjustment Layer pop-up menu 
at the bottom of the Layers panel and 
choose Photo Filter. These Photo Filters 
replicate the traditional screw-on lens 
filters used with film cameras to accom-
modate bad lighting situations. 

Step Thirteen:
In the Photo Filter dialog, you can 
choose a filter from the Filter pop-up 
menu (like the Cooling Filter [82] I chose 
here), or choose to fill with a solid color. 
You can also control the Density of the 
effect using the Density slider (I lowered 
it to 14%). Click OK and the warm areas 
are cooled, so your subject’s flesh tones 
now better fit the background image 
you dragged him onto. 

The original photo The subject extracted, placed onto a  
different background, re-cropped, and his 
tone cooled to match the new background. 


